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1 Introduction

1 Introduction

Security Assertion Markup Language (SAML) is a standards-defined protocol. The specification
defines the syntax and semantics for assertions made about a subject. Subjects are typically end
users of a system. SAML assertions and protocol messages are XML-encoded but rely on HTTP-
based mechanisms for transport between entities.

SAML enables web-based Single Sign On (SSO). It also provides for centralized federated identity
and authentication management. Microsoft Active Directory Federation Services (AD FS) is the
SAML-based Identity Provider (IdP) which has been tested and which is referred to in this
document. However, other IdPs may also work. AD FS is a standards-based service running on a
Microsoft box that allows the secure sharing of identity information between trusted parties. In
general terms, this is known as a federation. AD FS supports SAML, essentially playing the role of a
SAML IdP. The LoadMaster supports SAML, playing the role of a SAML service provider. The service
provider provides secure, gated access to a resource.

1.1 Document Purpose

The purpose of this document is to provide information and instructions on how to configure SAML
authentication with the Kemp LoadMaster.

1.2 Intended Audience

This document is intended to be used by anyone who is interested in finding out further
information about using SAML authentication with the LoadMaster.

1.3 Related Firmware Version

Published with LMOS version 7.2.48.3 LTS. This document has not required substantial changes
since 7.2.48.3 LTS. However, the content is in sync with the latest LoadMaster LTS firmware.
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2 SAML Authentication Flow

When using other Edge Security Pack (ESP) authentication protocols in the LoadMaster, end users
are presented with the standard Kemp login form. This is not displayed by LoadMaster when using
SAML because a login form is not provided by Kemp. The LoadMaster instead redirects the client to
a login form which is located at the I1dP.

The LoadMaster implementation relies on protocol bindings for HTTP redirect which is used for
redirections to a claims provider, alternatively known as an IdP. The LoadMaster also has a
dependency on HTTP POST - the LoadMaster expects HTTP POST messages for IdP responses,
where applicable.

The domain is fundamentally different to other types of SSO domain that are configurable on the
LoadMaster because the LoadMaster does not interact directly with the authentication server (AD
FS in this scenario). The LoadMaster redirects and informs the client to interact directly with AD FS
so that the client can input the credentials that are required for authentication.

The URL provided in the original request from L7 is preserved. This URL is given precedence over
the destination URL from the SAML response. For example, if a user logs in to a URL such as
https://sharepoint.kemptest.com/personal/admin, they are directed to
https://sharepoint.kemptest.com/personal/admin and not https://sharepoint.kemptest.com.
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2 SAML Authentication Flow

Here is a description of the flow:
1. The client attempts to connect to the Virtual Service on the LoadMaster.

2. The LoadMaster identifies that there is no cookie for the session. As this is a SAML-based
domain - the authentication request is built.

3. The client is informed to redirect to the IdP.

4. The client sees the login form from the IdP federation server and enters their credentials.
This interaction is between the client and the IdP. The credentials are passed between the
client and the Federation Server.

5. The IdP parses the SAML request and authenticates the user.
6. The IdP generates the SAML response.
7. The IdP returns the encoded SAML response to the browser in the URL.

8. A POST request, including the SAML response is passed back to the Service Provider (the
LoadMaster).

9. The LoadMaster validates the contents of the SAML response and grants/denies access.
Back-end KCD processing is performed at this point, if KCD is in use.

Logging out results in another series of events:
10. The user signs out.

11. The client gets logged out of the LoadMaster and redirected to the IdP again to allow
the user to log back in, if necessary.

12. A logout response is passed from the IdP to the client.

13. A logout response is passed from the client to the LoadMaster.

This flow is known as SP-initiated authentication; IdP-initiated
authentication is not supported.
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3 AD FS Settings

Some information is provided below on some of the key AD FS settings. The AD FS settings can be
configured using the AD FS management console which is available in the Server Manager by going
to Tools > AD FS Management.

3.1 Terminology Differences

There is a difference in terminology between AD FS terms and SAML terms. AD FS supports SAML
and implements SAML but the terminology associated with AD FS varies in comparison to the
terminology that is used in the context of SAML.

Some examples of these terminology differences are provided in the table below.

ADFS SAML Name Concept
Name
Security ) A package of security information, describing a user, created and
Assertion .
Token consumed during a federated access request.
Claims Identity

) ) Partner in a federation that creates security tokens for users.
Provider Provider (IdP)

Relying Service Partner in a federation that consumes security tokens for providing
Party Provider (SP) access to applications.
. Assertion . - .
Claims ) Data about users that is sent inside security tokens.
attributes

3.2 Ensure the Services are Running

Before making changes to the AD FS settings, ensure the Active Directory Federation Services and
Device Registration Service are running.

To do this, follow the steps below:

1. Click the Start menu in the bottom-left corner of the screen.
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Search

Everywhere -

run

View recommended actions to
keep Windows running smoothly

Show which operating system
your computer is running

2. Type run and click the Run option.
=) Run -

=7 Type the name of a program, folder, document, or
' Internet resource, and Windows will open it for you.

Open: ServVICes.msc

] 4 Cancel Browse...

3. Enter services.msc and click OK.
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Name - Description  Status Startup Type Log On As
"..ﬂ Active Directory Certificate Services Creates, ma.. Running Automatic Local Syste...
J, Active Directory Domain Services AD DS Dom... Running Automatic Local Syste...
*1 Active Directory Federation Services Enables Acti... Running Automatic (Delayed Sta... SAMLTEST...
L. Active Directory Web Services This service... Running Automatic Local Syste...
’..4-, App Readiness Gets apps re... Manual Local Syste...
% Application Experience Processes a... Manual (Trigger Start) Local Syste...
., Application Host Helper Service Provides ad... Running Automatic Local Syste...
£, Application |dentity Determines ... Manual (Trigger Start) Local Service
4, Application Information Facilitates t... Running  Manual (Trigger Start) Local Syste...
% Application Layer Gateway Service Provides su... Manual Local Service
Sm Application Management Processes in... Manual Local Syste...
. AppX Deployment Service (AppXSVC) Provides inf... Manual Local Syste...
% ASP.NET State Service Provides su... Manual Network 5...
J Background Intelligent Transfer Service Transfers fil... Manual Local Syste...
% Background Tasks Infrastructure Service Windows in... Running Automatic Local Syste...
. Base Filtering Engine The Base Fil... Running  Automatic Local Service
"...p, Certificate Propagation Copies user... Running Manual Local Syste...
54 CNG Key Isolation The CNG ke... Running  Manual (Trigger Start) Local Syste...
%, COM+ Event System Supports Sy.. Running  Automatic Local Service
t:uﬁ COM+ System Application Manages th... Manual Local Syste...
4 Credential Manager Provides se.. Running  Manual Local Syste...
‘%4 Cryptographic Services Provides thr... Running Automatic Network S...
%, DCOM Server Process Launcher The DCOM... Running Automatic Local Syste...
'}, Device Association Service Enables pair... Manual (Trigger Start) Local Syste...
5, Device Install Service Enables a c... Manual (Trigger Start) Local Syste...
., Device Registration Service Enables Dev... Running Automatic SAMLTEST...

4. Ensure the Active Directory Federation Services is running. If it is not, right-click it and

click Start.
Name - Description Status Startup Type Log On As
.. Device Install Service Enables a c... Manual (Trig.. Local Syste...

# 3 Device Registration Service Enables Dev.. Running Autematic SAMLTEST...

%, Device Setup Manager Enables the ... Manual (Trig... Local Syste...

5. Ensure the Device Registration Service is running. If it is not, right-click them and click
Start.
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3.3 Service Settings

s e

Add Relying Party Trust...

Overview
AD FS provides single-sign-on (SS0) access for client computers.

Add Claims Provider Trust...
Leam More Add Attribute Store...
Configuring Trust Relationships Edit Federation Service Properties...
Configuring Authertication Policies Edit Published Claims

Troubleshooting AD F5 Revoke All Proxies

AD FS Help View »
New Window from Here

(@i Refresh

ﬂ Help

To access the Federation Service Properties, click the AD FS folder and click Edit Federation Service
Properties on the right.
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General | Organization | Events
Federation Service display name:

samitest comporation|

Example: Fabrikam Federation Service

Federation Service name:

espadfs samitest.com

Example: fs fabrikam.com

Federation Service identifier:

hitp://espadfs samitest.com/adfs/servicesArust
Example: http://fs fabrikam com/adfs/services Arust

Web 550 Ifetime: 480 -2- minutes
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welcome to samltest
corporation

Sign in with your organizational account

Sign in

The Federation Service display name is the corporation name. This is shown on the log on screen
when the client is redirected to the form-based authentication on the IdP. In the example
screenshot above, the Federation Service display name is set to samltest corporation.

The Federation Service name is the qualified server name (Fully Qualified Domain Name (FQDN)) for
this federation service (AD FS).

The Federation Service identifier is the IdP entity ID, such as http://<FQDN>/adfs. This must match
the IdP entity ID in the context of SAML.
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General | Organization | Events

Select the types of events or audits that this Federation Service will record in
the event log.

[v] Emor events

V| Waming events
[vl Information evernts
[ ] Success audits
[ ] Failure audits

@ ¥ you select any of the audit check baxes, you must also enable
audting using the Local Secunty Policy snap-in before audits can be
recorded.

In the Events tab, the first three options should be selected.

3.4 Endpoint Settings

The Services > Endpoints folder contains a list of the endpoints that are served by AD FS.

Metadata
Yes Yes Jadfs/services/trust/mex WS-MEX
( i /FederationMetadata/2007-06/FederationMetadata xml Federation Metadata
Yes No /adfs/fs/federationserverservice asmx ADFS 1.0 Metadata
|
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The Metadata section contains a path to the FederationMetadata.xml file which can be imported
into the LoadMaster when configuring the SAML domain. This path will form part of a full URL
which includes the federation service server. Go to this URL (for example,
https://<FQDN>/FederationMetadata/2007-06/FederationMetadata.xml) in a web browser to
download the metadata file which can then be imported using the IdP Metadata File field in the
LoadMaster. Importing this file automatically populates the IdP Entity ID, IdP SSO URL and IdP
Logoff URL fields with the relevant data.

3.5 Certificate Settings

All communications between the service provider and the IdP (AD FS in this case) must be secure.
The certificate infrastructure must be in place on AD FS. Kemp assumes that this is in place in the
case of production environments. If setting up AD FS for the first time, please ensure the correct
certificate infrastructure is in place.

i File Action View Window Help

e nm

R
AR Scbject Issuer Effective Date  Expiration Date
| Endpoints - r
e Service communications
i Contficotes [EICN-=espadis sami CN=samhest- ESPADFSCA, DC=samhtest, DC=com  11/24/2016  11/24/2018
] Claim Descriptions dL\=espadis ” est.com est est, DC=com
4 [ Trust Relationships Token-decrypting
71 Claims Provider Trusts CN-ADFS Encryption - espadfs samitest.com CN=ADFS Encryption - espadfs samltest.com 11/24/2016 112472017
"] Relying Party Trusts Token-signing
[ Attribute Stores [EACN=ADFS Signing - espadis samitest com  CN=ADFS Signing - espadfs samitest com 11/262006 117242017
p [ Authentication Policies

In the Certificates folder, there are certificates for service communication, token decrypting and
token signing. The token signing certificate is important. When referring to tokens in AD FS, they
generally map to assertions in the context of SAML. The token signing certificate is used for signing
any response data from the AD FS. The LoadMaster requires this certificate to verify the signature
on the service provider side (that is, on the LoadMaster side).

Export the token signing certificate from AD FS by following the steps below:
1. Go to Services > Certificates in AD FS.

2. Select the Token-signing certificate.
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Ii

Add Token-5igning Certificate...

Add Token-Decrypting Certificate...

Set Service Communications Certificate...
View »
New Window from Here

@ Refresh

Help

View Certificate...
Set as Primary

Help

3. Click View Certificate.
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General | Details | Certification Path

Show: |<All> v
Field Value Fs
[=] version v3
-] serial number 1fa3ba 213 16 f798 44ee...
| signature algorithm sha256RSA =
|- | signature hash algorithm sha256
- | 1ssuer ADFS Signing - espadfs.samite...
[ |valid from Thursday, November 24, 2016...
[=] valid to Friday, November 24, 2017 11...
I |subject ADFS Signing - espadfs.samite... | v

Edit Properties... Copy to File...

4. Click Copy to File.

5. Follow the steps in the certificate export wizard.

6. Provide a filename for the certificate.

18
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You must convert the certificate to a .pem format before importing it to the LoadMaster. There are
many certificate converters available online. Alternatively, you can use an openssl command to
perform the conversion.

Import the .pem certificate into the LoadMaster by following the steps below in the LoadMaster
Web User Interface (WUI):

7. In the main menu, go to Certificates & Security > Intermediate Certs.

8. Click Choose File.

9. Browse to and select the certificate file.

10. Enter a Certificate Name and click Add Certificate.
This token signing certificate is now available to select in the IdP Certificate drop-down list in the
SAML SSO domain in the LoadMaster.
3.6 Claim Description Settings

The Claim Descriptions folder contains a list of all the claims that can be asked and provided for.
Usually this is backed up by Active Directory. There is a mapping between LDAP attributes and the
claims that can be provided by AD FS.

3.7 Trust Relationships Settings

The trust relationship is about establishing trust between an IdP and a service provider. In AD FS
terminology - the relying party is the service provider (the LoadMaster).

Identifiers are configured here in AD FS which are used when building request messages from the
service provider.

3.7.1 Ensure Active Directory is Enabled

To ensure Active Directory is enabled, click the Claims Provider Trusts folder.

| ADFS Claims Provider Trusts
4 | Service
- ) Display Name Enabled
f Endpoints e Dreciney Yea
|| Certificates

[ ] Claim Descriptions

4 [ Trust Relationships
| Claims Provider Trusts
[] Relying Party Trusts
7] Attribute Stores

4 [ Authentication Policies
|| PerRelying Party Trust
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3.7.2 Add a Relying Party Trust

To add a Relying Party Trust, follow the steps below:

7] ADFS

4 [ Service
] Endpoints
| Certificates
| Claim Descriptions

4 | Trust Relationships
"] Claims Provider Trusts
| Relying Party Trusts |
] Attribute Stores

4 [ ] Authentication Policies
| Per Relying Party Trust

1. Click the Relying Party Trusts folder.

Actions

Add Relying Party Trust...
Add Non-Claims-Aware Relying Party Tr...

View b
New Window from Here

.E_il Refresh
Help

2. Click Add Relying Party Trust.
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g Welcome to the Add Relying Party Trust Wizard
oW This wizard will help you add a new relying party trust to the AD FS configuration database. dengpatlles
@ Select Data Source consume claims in security tokens that are issued by this Federation Service to make authertication and
authorization decisions.
@ Configure Multifactor
Authentication Now? The relying party trust that this wizard creates defines how this Federation Service recognizes the relying
@ Choose lssuance party and issues claims to . You can define issuance transform rules for issuing claims to the relying party
Authorization Rul after you complete the wizard.
@ Readyto Add Trust
@ Finish
< Previous || Start || Cancel
3. Click Start.
|
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Steps

@ Welcome

@ Select Data Source
@ Specify Display Name
@ Choose Profile

@ Configure Certificate
@ Configure URL

@ Configure Identifiers

@ Conrfigure Muttifactor
Authentication Now?

@ Choose lssuance
Authorization Rules

@ Readyto Add Trust
@ Finish

Select Data Source

Select an option that this wizard will use to obtain data about this relying party:

() Import data about the relying party published online or on a local network

Use this option to import the necessary data and certificates from a relying party organization that publishes
its federation metadata online or on a local network.

Federation metadata address (host name or URL):
Example: fs contoso.com or hitps://www contoso.com/app
O Import data about the relying party from a file
Use this option to import the necessary data and certificates from a relying party organization that has
exported its federation metadata to a file. Ensure that this file is from a trusted source. This wizard will not
validate the source of the file.
Federation metadata file location:
| | Browse...
(® Enter data about the relying party manualy
Use this option to manually input the necessary data about this relying party organization.

| <Previous || Ned> || Cancel

4. Select Enter data about the relying party manually and click Next.

kemp.ax
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Specify Display Name
Steps Enter the display name and any optional notes for this relying party.
@ Welcome Display name:

@ Select Data Source |sariutmgparly|
@ Specify Display Name Notes:

@ Choose Profile

@ Configure Certificate
@ Corfigure URL

@ Configure Identifiers

@ Configure Muttifactor v
Authertication Now?

@ Choose Issuance
Authorization Rules

| <Previous || Net> || Cancel

5. Enter a Display name for the Relying Party Trust and click Next.
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Choose Profile
Steps This wizard uses configuration profiles to aid in creating the relying party trust. Choose the appropriate
@ Welcome corffiguration profile for this relying party trust.
@ Select Data Source (® AD FS profile
@ Specify Display Name This profile supports relying parties that are interoperable with new AD FS features, such as
security token encryption and the SAML 2.0 protocaol.
@ Choose Profile
@ Corfigure Cerfficate (O ADFS 1.0and 1.1 profile
@ Configure URL This profile supports relying parties that are interoperable with AD FS 1.0 and 1.1.
@ Configure |dertifiers
@ Configure Multifactor
Authentication Now?
@ Choose Issuance
Authorization Rules
@ Readyto Add Trust
@ Finish

| <Previous | | Net> || Cancel

6. Select the AD FS profile option (this supports SAML 2.0) and click Next.

kemp.ax 24 Copyright 2002-2021, Kemp Technologies, All Rights Reserved



SAML

3 AD FS Settings

kemp

Configure Certificate

Steps

@ Welcome

@ Select Data Source
@ Specify Display Name
@ Choose Profile

@ Configure Cedificate
@ Corfigure URL

@ Configure |dentifiers

@ Configure Muttifactor
Authentication Now?

@ Choose |ssuance
Authorization Rules

Specify an optional token encryption certificate. The token encryption certificate is used to encrypt the
claims that are sent to this relying party. hmmﬂwemeMeheydhswlﬁ:deto
decrypt the claims that are sent to it. To specify the cerdfficate, click Browse

lssuer:
Subject:
Effective date:
BExpiration date:

| View... || Browse... || Remove

| <Previous | | Net> || Cancel |

7. Click Next and do not add a token encryption certificate. Encryption is not supported.

kemp.ax
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Configure URL

Steps

@ Welcome

@ Select Data Source
@ Specify Display Name
@ Choose Profile

@ Corfigure Cerificate
@ Configure URL

@ Corfigure Identifiers

@ Configure Multifactor
ication Now?

@ Choose Issuance
Authorization Rules

kemp

ADFS u:puttame WS-Trust, WS-Federation and SAML 2.0 WebS5S0 protocols for relying parties. If
‘WS-Federation, SAML, or both are used by the relying party, select the check boxes for them and specify the
URLs to use. &ppmfuﬂ'nWS—TmstmwudmwmaHedforaldyngpaﬂy

("] Enable support for the WS-Federation Passive protocol

The WS-Federation Passive protocol URL supports Web-browser-based claims providers using the
WS-Federation Passive protocol.

Relying party WS-Federation Passive protocal URL:

Example: https://fs.contoso.com/adfss/

[[] Enable support forthe SAML 2.0 WebSSO protocol

The SAML 2.0 single-sign-on {SS0) service URL supports Web-browser-based claims providers using the
SAML 2.0 WebSSO protocol.

Relying party SAML 2.0 SSO service URL:

Example: https://www contoso.com/adfs/1s/

| <Previous || Net> || Cancel

8. Do not select either option on the Configure URL screen and click Next.

Relying parties may be identified by one or more unigue identifier stings. Specify the identifiers for this relying

party trust.

|htp:/ Aestesp|

Example: hitps://fs.contoso.com/adfs/services/trust

9. Enter the Relying party trust identifier in the form of a URL and click Add.

kemp.ax
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Relying party trust identifiers:
[ -/ Aest ‘ Remove
< Previous Next > Cancel
10. Click Next.
]
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Welcome

Select Data Source
Specify Display Name
Choose Profile
Corfigure Cerfficate
Corfigure URL
Corfigure Identifiers

Configure Multifactor
Authentication Now?

@ Choose Issuance
Authonization Rules

@ Readyto Add Trust
@ Finish

Configure multifactor authentication settings for this relying party trust. Multifactor authentication is required if
there is a match for any of the specified requirements.

Multifactor Authentication Global Settings

Requirements Users/Groups Not configured
Device Not configured
Location Net configured

(® | do not want to configure multifactor authentication settings for this relying party trust at this time.
(O Corfigure muttifactor authentication settings for this relying party trust.

You can also configure multi-factor authentication settings for this relying party trust by navigating to the
Authentication Policies node. For more information, see Configuring Authentication Policies.

| <Previous || Net> || Cancel |

11. Select | do not want to configure multi-factor authentication settings for this relying
party trust at this time and click Next.

kemp.ax
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Choose Issuance Authorization Rules

Steps

Welcome

Select Data Source
Specify Display Name
Choose Profile
Corfigure Cerificate
Corfigure URL
Configure Identifiers

Corfigure Multifactor
Authentication Now?

Choose Issuance
Authorization Rules

Ready to Add Trust
Finish

lssuance authorization rules determine whether a user is permitted to receive claims for the relying party.
Choose one of the following options for the initial behavior of this relying party’s issuance authorization rules.
(®) Pemit all users to access this relying party
The issuance authorization rules will be configured to pemmit all users to access this relying party. The relying
party service or application may still deny the user access.
(O Deny all users access to this relying party

The issuance authorization rules will be configured to deny all users access to this relying party. You must
later add issuance authorization rules to enable any users to access this relying party.

You can change the issuance authorization rules for this relying party trust by selecting the relying party trust
and clicking Edit Claim Rules in the Actions pane.

|<Pmlwl|| Next > || Cancel

12. Select Permit all users to access this relying party and click Next.

kemp.ax
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Ready to Add Trust

Stepa The relying party trust has been configured. Review the following settings, and then click Next to add the
@ Welcome relying party trust to the AD FS configuration database.

@ Select Data Source Mﬂ""‘“‘hghl tifi IE i |S " I' ted Clai |0 E— |EI 'Illl <[,
® Speciy Display Name Specify the monitoring settings for this relying party trust.

Choose Profile Relying party’s federation metadata URL:
Corffigure Certificate | l

]
@
@ Corfigure URL
]
@

[T] Monitor relying party
Corfigure Identifiers

Configure Multifactor [] Automatically update relying party

Authentication Now?
st This relying party's federation metadata data was last checked on:

@ Choose Issuance

Authorization Rules Soever>
@ Readyto Add Trust This relying party was last updated from federation metadata on:
< never >
@ Finish
<Previous || Nedt> || Cancel
13. Click Next.
14. Click Finish.
3.7.3 Add End Points

Now, add the end points by following the steps below:
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Actions

Add Relying Party Trust...

Add Non-Claims-Aware Relying Party Tr...
View »
New Window from Here

i Refresh

Help

Update from Federation Metadata...
Edit Claim Rules...
Disable
Properties
A Delete

Help

1. Go to the Properties of the relying party trust.

2. Select the Endpoints tab.

Add SAML...

Add WS-Federation... Remove Edi. ..

3. Click Add SAML.
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Endpoint type:

SAML Assertion Consumer N
Binding:

POST v

[] Set the trusted URL as default

4. Select SAML Assertion Consumer from the Endpoint type drop-down list.

5. Select POST as the Binding.

6. Enter the Virtual Service FQDN in the Trusted URL text box. Then, click OK.

Add SAML...

Add WS-Federation... Remove | | Edt..

oK Cancel Apply

7. Click Add SAML again to add the logout endpoint.
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Endpoint type:

SAML Logout v
Binding:

POST v

[[] Set the trusted URL as defaul

OK Cancel

8. Select SAML Logout as the Endpoint type.
9. Select POST as the Binding.

10. Enter the logout URL in the Trusted URL text box, for example
https://<VirtualServiceFQDN>/<LogoutURL>.

11. Copy the URL from the Trusted URL text box into the Response URL text box. Then, click
OK.
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Organization | Endpoints | Proxy Endpoints | Notes | Advanced
Specify the endpoints to use for SAML and WS-FederationPassive protocols.

URL index Binding Default
SAML Assertion Consumer Endpoints

https://mail kempqakcd net/owa 1 POST No
SAML Logout Endpoints

hitps//mail kempgaked net/owa POST No

Both URLs should point towards the Virtual Service.

3.7.4 Import the Certificate

Export the certificate from the LoadMaster by going to Virtual Services > Manage SSO, clicking
Modify on the SAML SSO domain and clicking Download.

To import the certificate in AD FS, follow the steps below:
1. Select the Signature tab.

2. Click Add.

3. Browse to and select the certificate that was downloaded from the LoadMaster.

In the context of log out processing - the service provider signs
the log out request message. Therefore, on the AD FS side -
there must be a certificate to verify that the signature is
accurate and correct for the message that was signed on the
service provider.
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Notes

Monitoring

Identifiers

Advanced

Accepted Claims

Specffy the signature verfication cerificates for requests from this relying
party.

Subject

Issuer

Effective
[E) E=support@kemptechnologies.c... CN=KEMP Tech... 10/18/20

4, Click OK.

3.7.5 Configure the Identifiers

Configure the identifiers by following the steps below:
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1. Select the Identifiers tab.

Organization | Endpoints | Proxy Endpoints | Notes | Advanced
Monitoring | Identfiers | Encryption | Signature | Accepted Claims
Specify the display name and identffiers for this relying party trust.
Display name:
kamitestingparty

2. Enter the Display name. This value should be entered as the SP Entity ID in the
LoadMaster.

3. For the Relying party identifiers, include all possible connotations of the URL, for
example http://<ID>, https://<ID>.

4. Click OK.
3.7.6 Claim Rules

A single claim is required. While multiple claims may be configured, it is recommended you use a
single claim only, which should be most appropriate for the environment. In the Claim Rule, the
LDAP attributes are mapped to the outgoing claim types. The LoadMaster supports:

- The User-Principal-Name which maps to the UPN (which is the
outgoing claim type)

- The SAM-Account-Name (which is the typical Windows
samAccountName attribute from an LDAP perspective) which maps to the
Windows account name

- The User-Principal-Name which maps to the Name ID outgoing
claim type

The User-Principal-Name is important because without it - a
session index is not included in the SAML response. The
session index is very important to correlate an existing session
and a log out operation.
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These three attributes are the minimum required. The UPN is required to proceed with KCD
processing on the back end.

To add the Claim Rule, follow the steps below:

] ADFS .: Relying Party Trusts

4 ] Service
Display Mame Enabled T
-] Endpoints e e
] Certificates

1 Claim Descriptions Update from Federation Metadata...
4 B .Tl:l.lit Relationships dit Claim Rules...

“| Claims Provider Trusts

Disable
| Attnbute Stores Piopaiia
4 [ Authentication Policies Delete
1 Per Relying Party Trust
Help

1. Select the Relying Party Trusts folder.

2. Right-click the relevant Display Name and select Edit Claim Rules.
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0 Edit Claim Rules for KEMPSAML = e

Issuance Transform Rules | lssuance Authorization Rules | Delegation Authorization Rules |
The following transform rules specify the claims that will be sent to the relying party.

You can configure this rule to send the values of LDAP attributes as claims. Select an attribute store from
which to extract LDAP attrbutes. Specify how the attributes will map to the outgoing claim types that will be

Mapping of LDAP attrbutes to outgoing claim types:

.%} saia Outgoing Claim Type (Select or type to add more)

User-Principal-Name
SAM-Accourt-Name
User-Principal-Name

3. Edit the relevant rule.

4. Add the attribute mappings.

| Issuance Transform Rules | Issuance Authorization Rules | Delegation Authorization Rules |

The following authorization rules specify the users that will be pemmitted access to the relying
party. When the list does not contain a rule, all users will be denied access.

Order Rule Name lssued Claims
1 Permit Access to All Users Pemit
S
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5. Ensure that all users are permitted access by selecting the Issuance Authorization Rules
tab.

3.8 Authentication Policies Setting

Right-click the Authentication Policies folder and select Edit Global Primary Authentication.
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Prmary | Mutifactor |

users to have a choice of what method to authenticate with at sign in.

¥ Integrated Windows authentication method is specified, it appears as the default
authentication method on browsers that support Integrated Windows authentication.

[ ] Enable device authentication
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Select the Primary tab. Depending on production requirements (external/internal, and so on),
Forms Authentication may need to be enabled for both the Extranet and Intranet. Deselect the
other options. Click OK to save the settings.
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4 Configure SAML
Authentication in the
LoadMaster

Follow the steps in the sections below to configure the options for SAML in the LoadMaster.

4.1 Limitations

Refer to the sections below for information on some limitations when using SAML.
4.1.1 Certificate Signature Verification

Since LoadMaster firmware version 7.2.40, the signature verification in the case of having a SAML
IDP Token Signing certificate, which was signed by your Root Certificate, will not (should not)
work.

In previous versions, you could set your SAML IDP Token Signing Certificate on your IDP Provider.
The Root certificate configured in your SSO Domain was then used to verify the signature and trust
was established.

Since 7.2.40, the certificate in the response must match the certificate assigned in the SAML SSO
domain. This means that your certificate can not be created by a Third Party Provider, such as Go
Daddy, and it should be a trusted Root Cert.

4.1.2 Persistent Cookies

The persistent cookie feature works with SAML. However, it is susceptible to browser behavior and
may be effective to use with Internet Explorer only. Also, depending on testing performed and
multiple cookies being in use, the cookie that can be used varies.

4.2 Configure the SSO Domain

SAML SSO domains are fundamentally different from other SSO domains which can be configured
on the LoadMaster. This is because the LoadMaster does not directly interact with the
authentication server. In the context of SAML, the LoadMaster performs redirections. The
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LoadMaster asks the client to redirect to an IdP to issue some claims and get the required
assertions back.

To configure a SAML-based SSO domain in the LoadMaster, follow the steps below:

1. In the main menu of the LoadMaster WUI, go to Virtual Services > Manage SSO.

Add new Client Side Configuration
ISAML_ADFS |

2. Enter a name for the SSO domain in the Add new Client Side Configuration text box and

click Add.
Authentication Protocol |SAML v
IdP Provisioning
1dP MetaData File Mo file chosen
IdP Entity ID http:hfespadfs.samltest.co m/adfs/services/trust |
167 550 URL  ittp://espadfs samltest.com/adfs/ls/ |
1dP Logoff URL  http:/iespadfs.samitest com/adfs/ls/ |

IdP Certificate |No certificate available v |
IdP Certificate Match [

SP Entity ID http:Htestesp | Set SP Entity ID
SP Signing Certificate | Use Self Signed v
Download SP Signing Certificate

Session Control [SP Session Idle Duration ¥ |

SP Session Idle Duration (secs) m Set SP Idle Duration

3. Select SAML as the Authentication Protocol.
4. Select the relevant IdP Provisioning option.

The Manual option enables you to manually input details into the IdP fields.

The MetaData File option enables you to upload an IdP MetaData File. This simplifies the
configuration of the IdP attributes, including the IdP Entity ID, IdP SSO URL and IdP Logoff URL.
The metadata file can be downloaded from the IdP. For further information, refer to the Endpoint
Settings section. To upload the file - click Browse, navigate to and select the relevant file and click
Import IdP MetaData File.

5. Select an IdP Certificate for use in the context of assertion verification.
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The certificate can be exported from the IdP and imported in
the LoadMaster in the Certificates & Security section.

The IdP Certificate is very important in terms of verification of
the assertions that must be contained in the SAML response
that is received from the IdP. Without the certificate,
verification cannot proceed.

6. Decide whether or not to enable the IdP Certificate Match check box.

If this option is enabled, the IdP certificate assigned must
match the certificate in the IdP SAML response.

7. Enter the SP Entity ID and click Set SP Entity ID.

This is an identifier that is shared to enable the IdP to
understand, accept and have knowledge of the entity when
request messages are sent from the LoadMaster. This must
correlate to the identifier of the relying party on the AD FS
server.

8. Select the relevant SP Signing Certificate option.

It is optional to sign requests that are sent in the context of logon. Currently, the LoadMaster does
not sign those requests.

In the context of log off requests - it is mandatory and these requests must be signed. This is to
avoid any spoofing and to provide extra security in relation to log off functionality. This ensures
that users are not being hacked and not being logged off unnecessarily.

In the SP Signing Certificate field, you can use a self-signed certificate to perform the signing.

9. If using a self-signed certificate, click the Download button to download the certificate.
This certificate must be installed on the IdP server (for example AD FS) to be added to the
relying party signature.

The AD FS server requires this certificate for use of the public key to verify the signatures that the
LoadMaster generates.

10. Select the relevant Session Control option.
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The IdP maximum duration value cannot be set in the
LoadMaster. The value is taken from the IdP protocol. If the
value is not already set in the IdP authentication response, the
default value of 30 minutes is assigned as the IdP maximum

duration.

11. If using SP Session Idle Duration, enter the SP Session Idle Duration and click Set SP

Idle Duration.

12. If using SP Session Max Duration, enter the SP Session Max Duration and click Set SP

Max Duration.

4.3 Configure the Virtual Service

Follow the steps below to configure the Virtual Service to use SAML authentication:

kemp.ax

1. In the main menu of the LoadMaster WUI, go to Virtual Services > Add New.

Please Specify the Parameters for the Virtual Service.

Virtual Address

Port

Service Name (Optional)
Use Template

Protocol

[10.154.30 221

[Example Virtual Service|

| Select a Template v |

Add this Virtual Service

2. Enter a valid IP address in the Virtual Address text box.

3. Enter the Port.

4. Enter a Service Name.

5. Click Add this Virtual Service.

6. Expand the ESP Options section.
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ESP Options
Enable ESP @
ESP Logging User Access: v Security: ¥ Connection: ¥
Client Authentication Mode |SAML ¥ |

$S0 Domain | ESP.SAMLTEST.COM v |

Allowed Virtual Hosts [testga.samltest.com |
Allowed Virtual Directories Il* |
Pre-Authorization Excluded Directories | |
Use Session or Permanent Cookies | Session Cookies Only v |

Logoff String  Jsignout.aspx | Set SSO Logoff String

Additional Authentication Header | Set Additional Authentication Header

Server Authentication Mode | KCD v |

Server Side configuration | KCD.SAMLTEST.COM v

7. Select the Enable ESP check box.

8. Select SAML as the Client Authentication Mode.

9. Select the SAML SSO Domain.

10. Enter any Allowed Virtual Hosts, as needed.

11. Enter the Logoff String and click Set SSO Logoff String.
The Logoff String is important. The Logoff String has a special
protocol flow associated with it in the context of SAML. Not

only do you want to log out of the Service Provider on the
LoadMaster, but the user also must be logged out of the IdP.

12. If required, enter the Additional Authentication Header and click Set Additional
Authentication Header.

The Additional Authentication Header specifies the name of the
HTTP header. This header is added to the HTTP request from
the LoadMaster to the Real Server and its value is set to the
user ID for the authenticated session.

13. Select the Server Authentication Mode.
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The Server Authentication Mode can be set to None, KCD, or
Server Token. Basic Authentication is not supported because
the LoadMaster does not have access to the username and
password.

If you select Server Token as the Server Authentication Mode
on reception and verification of the SAML response, the
LoadMaster requests a long-lived token. The LoadMaster then
builds a redirection URL with the token specified.

14, If using KCD as the Server Authentication Mode, please select the relevant option for
Server Side configuration.

For further information on KCD, refer to the Kerberos
Constrained Delegation, Feature Description.

15. Configure any other settings as needed.

kemp.ax 47 Copyright 2002-2021, Kemp Technologies, All Rights Reserved



SAML

5 Appendix A: Logging

< kemp

5 Appendix A: Logging

There are very detailed logs available to assist in investigating issues. Some things to look out for
in the logs are:

Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Hun

07:

07:

45:38 1bloo

:45:38 1b100
145:38 1bloo
145:38 1bloo
14538 1b100
145138 1bloo
:45:38 1b100O
145138 1b100
:45:38 lbloo
145:38 1b100
14538 1bloo
14538 1bloo
14538 1b100
145:38 1bloo
:45:38 1b100O
14538 1bl00
145:38 1bloo
145:38 1b100

45138 1b100

ssomgr
sEOmgr;
S50mgr:
ssomgr!
ssomgr:
ssomgr:
ssomgr:
sSsomgr:
ssomgr:
SSOmgr:
ssomgr:
ssomgr:
ssomgr:
ssomgr!
ssomgr:
SEOmMQF:
ssomgr:
ssamgr;
ssomgr:

find_user_by_cookie) fal#95fS5c08bSfc0ealBES010b7c4171)

#14566¢ ---- OxPoBhlOOERdel --> free()

#145668 ---- DxZhBL1OO00OBED -->= free()

=>find_user_by cookie{): up==NULL

#145668 ===get_domain

#145668 >>>get_domain_from_user

#14566# get_domain_frem_user: no domain to extract frem []

2145668 get_domain: client domain not provided, proceed with default domain [SaML_ADFS] for VS[4]
#145668 get_sso_conf: domaine|SAML_ADFS| refcountm2

2145668 ===generate_ID: Generate ID for SAML AuthnReq

#1ASEEY ++++ Ox2ZbBb100C2aa0 =-- malloci42)

#145668 generate_random_sequence: sequence [034534b6-fBec-4230-bf34-f655b7cofes2]

2145668 <<<generate_ID: ID string generated [_034534b6-fBec-4230-bf34-fE50bTcofas2]

2145668 »===build_sanl_auth_req: Start processing to build AuthnReq for SAML

#1 45668 >>>generate_Issuelnstant: Generate Issuelnstamt for SAML Req

2145668 ++++ Ox2bBblOODIAEN <-- malleci2l)

#14566F <<<generate_IssurInmstant: IssueInstant generated [2016-06-15T07:45:38Z]

#145668 ---- Ox2bBb1EEGE94EE --= freel)

2145668 build_saml_auth_req: AuthnReg XML string:[<samlp:AuthnRequest xmlns:samlp="urn:oasis names:tc:s

c-4230-bf34-fE58b7c5fe52" Version="2.0" Issuelnstant="2016-06-15T07:45: 382" Destination="https://fs espworld.con/adfs/ls/" ProtocolBd
nl Issuer= </sanlp: AuthnReguest=]
Jun 15 07:45:38 1b100 ssomgr: #145EEF ﬁ)m Start SAML AuthnReq Request encoding. ..

- Ens

ure there is a SAML domain assigned

- An ID must be generated for the request

- The SAML request is encoded

- The authentication request is built up and sent back down to L7

Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun

Hun

TETOTTT
o7
07
o7:
07:

o7

o7:
o7
o7:
o7

45:42 1b10C ssomgr:
4642 1bh1l00 ssomgr:
46:42 1bl00 ssomgr:
46142 1hl00 ssamgr:

145142 1b100 ssomgr:

45:42 1b100G ssomgr:
4642 1hl00 ssomgr:
46:42 1bl00 ssomgr:
46:42 1b100 ssomgr:
es/esptest” Consent="urn:oasis:names:tc:SAML:2.0:consent :unspecified” InResponseTo="_034634b6- fBec-4230-bf34- fE55bTcofe52" xmlns
sertion*=http://fs . espworld.com/adfs/services/trust=/Issuer><sanlp:Status><samlp:Stat ode Value="urn:oasis:names:tc:SAML:2, 0: st
Instant="2016-06-15T07: 46:38, 445Z" Version="2,0" xmlns="urn:ocasis:names:1c:SAML: 2.0 :as5ertion"=<Issuer=httip://fs.espworld.com/adi
ignedInfo=<ds:CanonicalizationMethod Algorithm="http://wew w3, 0org/2000/10/xml -exc-cldn#” f=<ds:SignatureMethod Algorithm="http:/
Jun 15 07:46:42 1bl00 ssomgr:
Jun 15 07:45:42 1b100 ssongr:
Jun 15 07:45:42 1b100 ssomgr:
Jun 15 07:46:42 1b100 ssomgr:
4230-bf34-fe=9b7coafes2

#1 45668 ===get_domain

2145668 ===get_domain_from_user

#145668 get_domain_from_user: no domain to extract from []

2145668 get_domain: clisnt domain not provided, proceed with default domain [SAML_ADFS] for WS[4]
#145EE# get_sso_conf: domain=|SAML_ADFS| refcount=2

#14566# >>>decode_saml_resp: Start SAML Response decoding...

#145668 ++++ Ox2bBbl0O00e61l0 =-- malleci 4009)

#14566F =>»>parseXnlMemory: Start parsing the SAML Resp XML

145664 FETETRDINEIEIRE SAML Resp XML: [4007][<sanlp:Response ID="_91046ac4-f871-4ee8-9707-d207d59:

#14566# ==>processhode! Start node processing

#145EE# processMode:#++ Processing node nane[Response]

#14566F processMode: *%+¥ matched nodePtr->name[Response]

2145668 processMode: ke ID:_ 91046acd- FBTL-deeB- 0707-d207d5935407, Version:2.0, Issuelnstant:20Ll6
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- At some point later, a response is received

- An XML-encoded SAML response gets parsed

- Some of the information which is in the SAML response is displayed

- That information is processed
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- The required pieces are extracted to perform a significant amount of
verification checks

Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun
Jun

Jun
Junm
Jun
Jun
Jun
Jun
Jun

15
15
15
15
15

15
1=
15
1=
15
13
15

15
15
15
15
15
15
15

o7:
146142 1bloo
o7:
o7
146:42 1bloo
07:
o7:
07:
a7:
146142 1b100
o7:
14642 1bloo
146142 1hl0o0
a7
o7
o7:
o7:
o7:
o7:
o7
o7:

o7

46742 1b100

46:42 1b100
46142 1hloo

46:42 1b100
45:42 1blo0
45:42 1bloo
46:42 1h100

46:42 1b100

46:42 1bl0o0
46142 1b10o0
45:42 1bloo
46142 1h100
45:42 1bloo
46:42 1blo0
45:42 1b100
46:42 lbloo

ssomgr:
sSsomgr:
Ssomgr;
ssomgr.
ssomgr:
ssamgr.
sSsomgr:
S50mgr:
SsOmgr.
SSoOmgr:
S50mgr!
sSsomgr:
SSOmgr:
ssomgr;
ssomgr:
sSsomgr:
Ssamgr.
ssomgr:
SSOmgr:
ssomgr:
SSOmgr:

2145668
#14566%
#l45668
#1 45662
#lacoed
#145668
#14506#
#14cEcd
2145668
#145668
#l45668
#145668
#l4566%
#l45668
#1 45668
#laseed
2] 45668
#14566#
#l45668
2145668
#l4566#

<<<print_saml_resp: Finished printing the corrtents of the SAML Response data
<<=decode_saml_resp: Finished SAML Response decoding

seoyverify_saml_resp: Start SAML Response verification, ..

===yerify_Assertion: Start SAML Response Assertion verificationm...

<<<verify Signature: Start Signature verification

==syverify_signature_node_by_cert: Start Signature node processing, cert_filel/onsdnet/3rdcerts/E
=<<verify_signature_node_by_cert: Success - Signature is OK

-=-=¢ver:|.‘Fv signature_node_by_cert: Completed Signature Mode verificatien rclo]

<<<ver1fr Signature: End Signature verification: rcl0]

Start SAML Response Assertion SCD NOOA verification.
verity_Assertion_SCD _NOOA: Assertion SCD NotOnOrafter = [2016-06-15TG7:51:38. 5232”14659??098]
<<eyerify_Assertlon_SCD_NDOA: Assertion SCD NotOnOrAfter is OK

-c-:-:uer:l.'Fy Assertion: [Sinished SAML Response Assertion verification. ..

=ssyerify_IDs; input raneters [_034634b6- fHec-4230-bT34- 16550 7caTe52] [_034634b6- f8ec-4230-b T34
==ayerify_IDs: Success - all IDs match up

»»sverify_Issuer: Correlate IDP Entity IDs, Response[http://fs.espworld.con/adfs/services/trust]
<<<verify_Issuer: Success - SAML Response from expected Entity IDIhttp://fs.espworld.com/adfs/se
==»verify_Status: input parameter [urn:oasis:names:tc:SAML:2.0:status:Success]

<==yerify_Status: Success - StatusCode Value is Success

=<<verify_saml_resp: Finished SAML Response verification - ALl OK

<<<mpap_user: User credential to be used[sp_user@ESPWORLD. COM]

- When finished processing the XML, the verification steps begin

- As part of the verification:

- The signature is checked to ensure it is OK

- The “Not On Or After” (NOOA) time is checked to ensure that time has not
passed because the assertion has a lifetime associated with it

- All of the IDs are checked to ensure they match. There is an original ID which is
allocated as part of a request. That ID is received back as part of a response so it
is checked to ensure it matches in two places in the response document.

- The issuer is verified to ensure that the response is received from the IdP which
was configured previously
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- A success code is displayed in the response. That has to be successful to
indicate that the user was successfully authenticated at the IdP.

- The username entered when signing in is displayed

- Next, the KCD processing occurs (if relevant)

- Once the KCD processing is finished, the site is browsed
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Jun 15 07:47:21 1b100 ssomgr: #14566# operation == (EEJET

Jun 15 07:47:21 1bl00 ssomgr: #14566# >==get_domain

Jun 15 07:47:21 1b100 ssomgr: #14566# ===get_domain_from_user

Jun 15 07:47:21 1bl0G0 ssomgr: #14566# get_domain_frem_user: no domain to extract frem []

Jun 15 07:47:21 1b100 ssomgr: 2145658 get_domain: client demain not provided, proceed with default domain [SAML_ADFS] for VS[4]
Jun 15 07:47:21 1b100 ssomgr: #14566# get_sso_conf: donain=|SAML_ADFS| refcount=2

Jun 15 07:47:21 1b160 ssomgr: #14566# >==gensrate_ID: Generate ID for SAML AuthnReq %

Jun 15 07:47:21 1b100 ssomgr: #14565¢ ++++ Ox2bBbI000aSeD <-- malloc(42)

Jun 15 07:47:21 1b100 ssomgr: #14566# generate_random_sequence: sequence [172040bf-4029-44fd-a67d-B808199c6c6ed]

Jun 15 07:47:21 1b160 ssomgr: 214566# ===gensrate_ID: [0 string generated [_172040bf-4029-44fd-a67d-805199c6c64]

Jun 15 07:47:21 1b100 ssomgr: 2145668 ===huild san‘L _logout_req: Start processing to build Logout Request for SAML

Jun 15 07:47:21 1b10G0O ssomgr: #145658 ::rgenerate_IssueInstan‘t: Generate IssueInstamt for SAML Reqg

Jun 15 07:47:21 1b100 ssomgr: 2145668 ++++ Ox2bBhl00CEG40 <-- malloc(2l)

Jun 15 07:47:21 1b100 ssomgr: #14566# <<<generate_IssueInstant: IssueInstant generated [2016-06-15T07:47:217]

Jun 15 07:47:21 1bl00 ssomgr: #14566# ---- Ox2bBbl0OCORG40 --> freel)

Jun 15 07:47:21 1b100 ssomgr: #14566# build_sanl_logout_req: Logout Request XML string:[=samlp:LogoutRequest xmins:samlp="urn:oas
040bf - 4029- 44 d - a67d - BOB199cEcEe 4" Version="2,0" Issuelnstant="2016-06-15T07:47:21Z" Destination="https://fs, espworld, confadfs/1s
= =sanlp:SessionIndex=_369b28b4-abcO-4608-bOTf-d28daS67128b</sanlp Sessionlndex= </samlp: LocoutRequest>|

Jun 15 07:47:21 1b100 ssomgr: 2145662 ===encode_saml_req: Start SAML LogoutReq Request encoding. .

Jun 15 07:47:21 1bl0O ssomgr: #145668 ++24 Ox2bBb100OBE20 <-- malloc|906)

Jun 15 07:47:21 1b10C0 ssomgr: 2145668 encode_sanl_req: Encoded blob: FZFRT4MWFLES 2FCul 7oWBXoNm IRnwg 22w ZRhNTLKKLLoG2ck vez 7 ThHIKS 26%
BaBRUSOrt 4z0h1D0dpiTIMaWd x IKL Enck 1% 2F0BZS1TFAUag Tvr JCw BCLARCoNTng nTyRanDACLSS Iy nnkk% 2Fg NBaXf cdDCna0PSy 2wK0og VGC: 2FzNj Ls DVDIGGHUG
Wialmm] GSAIVIHZZ ) JsWBp TMNLzx 8z% 2BLn% 28% 2B g% 2F1 Gw' 30% 3D

Jun 15 07:47:21 1b100 ssomgr: #14566# <<<encode_saml_req: Finished LogoutReg Request encoding

Jun 15 07:47:21 1b100 ssomgr: #14565# build saml logout req: SAMLRequest Blob:[436] [ SAMLRequestsfZFRT4MeFIN%2FCul ToWBXoNnT Rrvg 22l
2I0PAK J1 BNxp] USUT L% ZBNy SAGE 3BaBRUSOrt 420h1 D0dp1TIMaWdx IK] Encki% 2FO8ZS1TFAUVagTY r JCvBCLAP CoNTmI nTy RmmDACL5S Jymnkk s 2FghSa X f cdDCnaoF)
PzM3HhLaBVnAZUNG pj sbShe ZNkDeWialnn] GS4IW2HZZ I IsWBp THMMNLz x B2% 2BL n% 2B% 28q% 2F 10w% 305 30]

Jun 15 07:47:21 1b100 ssomgr: #14566# build saml_logout_req: cfg-»sp_cert:UseSelfSigned, def_samlcert:sanl_self_signed

Jun 15 07:47:21 1b1G0 ssomgr: 21456588 fonednet/certs/.saml_self_signed.pen: signing cert_file

Jun 15 07:47:21 1b100 ssomgr: #14566# ==»query_sign: Start processing to Sion Logout Reguest for SAML

Jun 15 07:47:21 1b10G0 ssomgr: #14566# ===query_sign: Query|SAMLRequest=TZFRTAMWFLN%2FCul TowWBXoNn I Anwg2ZwZRhNFLkKLLeG2ckvcz 7TbMIk%
Gt 3BaBRUSOrt4z0h1 D0dpiT IMaWdx IKL Encki% 2F08ZS1TFAUVagTy r JCvBCLAp CaNTmj nTy RemDACLSS Jymnkks 2FghBaX f cdDCha0P Sy 2wk 0o g VGCh 2FzN) LsDVDIGO
kDcwWialnm) GSATV2HZZ ] IsWBp TMMLzxBz% 2BLn% 2B% 2Bq% 2F1Gws3D%30] , SigAlgll], Key filel/onednet/certs/.saml_self_signed.pem]

Jun 15 07:47:21 1b1GC ssomgr: #14566¢ query_sign: Added SigAlg...[SAMLRequest=TZFRTAMWFIN%2FCul ToWBXoNnIRnwo2ZwZRhNTlkKLLoG2ckvez
% ZBNwSAG 3BaBRUSOrt 420h1 DOdpiTIMawdx IKL Enck 1% 2F0BZS1TFAUY ag T r JCw BCLApCoNTm] nTy RnnDACLSS Jymnkks 2FgNBaXf c dDCna0PSy 2wkDo gVGCs 2FzNj L
shSheZNkDcWialnm) GSAIV2ZHZZIIsWBp 7TMNLz xBz% 2BLn'% 2B% 2Bg’% 2F1 Gw’ 30% 3DAS1gAL g=htt p%3A% 2P 2Fwww . w3, org% 2F2001% 2F04% 2Fanl dsig-nore%23rsa-

- At some point there is a log out operation
- An operation is seen for L7 authentication SAML logout
- The logout request is built
- The logout request is sent to L7
- The client redirects to the logout

- A digest is created and there is a full query string
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